
USER GUIDE: T4A GPS Maps
Subscription Download Links

(For Windows)
Download Links are digital files that you have purchased and are emailed to you, or that you may have

downloaded from your user account on our site etc. and then:
● You would want to install them on your PC

● Then transfer them to your GPS unit

*Note: These Download links are purchased as Subscriptions from our site (ie. yearly map updates), and can be
purchased for the entire African continent, or per region like Namibia, Botswana, South Africa Northern & Western

Cape etc.

Document Date: 28-January-2022

https://youtu.be/w_ZEfBWIoNI
https://youtu.be/yRIz64qYABM


Before you get started, please read here
Important points, all discussed in this document.

Note that the T4A GPS Maps Subscription Download Links:
● Are compatible with Garmin GPS Units only
● Will require you to install them on your PC and then transfer the maps to your GPS

unit via Garmin Software:
○ You will make use of free Garmin Software, like Basecamp, MapInstall or

Mapsource. This will also enable you to view the maps on your PC too, which is
useful for trip planning.

○ If you prefer to just transfer your GPS maps directly from your PC to your GPS
unit, without viewing them on your PC - an easier option can be to transfer an
Image (IMG) file. See the section on our User Guides page: “IMAGE FILE User
Guide”.

● Are available on our online store only. Your purchase is registered on our system
and:

○ Complete & Single Download Map Sets: once purchased, you will be entitled
to all the map updates we release within the next 12 months or 5 years,
depending on the subscription you purchased. This could be up to four
updates a year, as we aim to release updates every quarter, but it may also
depend on the number of changes we make to our map content. We will
however make sure we release at least two map updates per year.

■ Any future purchase of the complete set 1 year subscription / GPS
Maps on SD Card will then be at a 50% discount regardless of when
you come back to buy.

● Take note of a few important settings on your GPS in order to make the most of your
T4A GPS Maps.
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HOW TO USE THIS GUIDE

See how to use the QUICK GUIDE SECTION as your point of
reference

Start by referencing the Quick Guide Section:

See how each step in the QUICK GUIDE SECTION references
the DETAILED STEPS IN THE APPENDIX
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Also note, that if you do reference the Appendix, please be sure to follow the links to
“Go Back to Quick Guide section” - don’t just continue into the next Appendix section
- it may confuse you.

Okay, let’s get started!
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QUICK GUIDE SECTION - Start here

1. How to Access and Install T4A GPS Maps to your PC
The  GPS Maps you purchased as a downloadable link from Tracks4Africa, is a data file.
The data is compressed into a zipped file. In summary you will:

● Need to then open and install that GPS Map file onto your PC.
● Then transfer the GPS Map to your Garmin unit.

Step Summary See Detailed Steps
Here

Step
A

Find and download the downloadable zip file
(containing the T4A GPS Map you purchased) to
your PC: Summary Steps: File is available:

● On our online shop:
○ On the Shop Checkout screen, on the final

Order screen
○ OR under “My Account” > Subscriptions

● OR on your final order email in your inbox
● OR from a download links email from T4A

See Appendix Item 1A
for more detailed steps

Step
B

Open the zip file, and run the exe to install the T4A
GPS Maps onto your PC.

See Appendix Item 1B
for more detailed steps

Step
C

In order to view the maps on your PC - Install Free
Software: BaseCamp / MapSource / MapInstall:

See Appendix Item 1C
for important info on
this software
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BaseCamp:
(Recommended)

View the T4A GPS maps, plan trips etc. and transfer &
receive maps, waypoints etc. to and from a GPS unit. (ie.

the MapInstall function resides within BaseCamp too)

Click here to download Garmin BaseCamp for free

and then install it on your PC.

Install BaseCamp
on Windows

OR MapSource:
(Older software, more popular than Basecamp)

Please note: Before installing MapSource, you will have to
install BaseCamp, otherwise the MapSource installation

won’t work.

MapSource allows you to view the T4A GPS maps, plan
trips etc. MapSource can  transfer & receive maps,

waypoints etc. to and from most Garmin GPS units -
the Garmin Drive GPS units don’t always work with

Mapsource.

Click here to download Garmin MapSource for free

and then install it on your PC.

Video not
available.

AND/OR MapInstall:

Note that “MapInstall” is a feature incorporated in
BaseCamp. One can also download and install MapInstall

separately, which purely transfers the GPS maps to your
GPS Garmin Unit. You cannot view the GPS maps or do

trip planning etc. in MapInstall.

Click here to download MapInstall for free

and then install it on your PC.

Install MapInstall
on Windows

Step
D

Open and View the installed T4A GPS Maps on
your PC, using:
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*Note: You cannot access and view the maps via
MapInstall - that is purely used to transfer the maps from

your PC to your GPS Unit.

BaseCamp:

Summary Steps:
● Open BaseCamp

● In Menu: Maps (ie. select the maps you installed & want
to view)

See Appendix Item 1D
for more detailed steps

OR

MapSource:

Summary Steps:
● In Menu > Switch to product (ie. to select map to you

installed & want to view)

See Appendix Item 1E
for more detailed steps

Steps A to D above are available on our
Youtube channel. We suggest you go through
the steps above first as there is some software
you will need to install first that is mentioned in

this video.

Install T4A GPS Maps on Windows (From
Digital Download)
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2. How to transfer T4A GPS Maps from your PC to your GPS

● Since you’ve purchased T4A GPS Maps via Downloadable files, and installed them onto
your PC, you now need to transfer them to your GPS unit in order to use them on your
Garmin GPS unit.

Step Summary See Detailed Steps
Here

Step A Connect your Garmin GPS Unit to your PC via
USB cable.

See Appendix Item 2A
for more info

Uninstall any previous T4A GPS Maps from your
GPS unit.

See Appendix Item 2AA
for more info

Step B Open  MapInstall / BaseCamp / MapSource that
you installed, and transfer the maps to your GPS.

Via MapInstall: (recommended option)
Summary Steps:

● Find Device
● Choose device to install maps on (ie. internal GPS

memory or SD Card)
● Click ‘Customize’

● Select maps to transfer
● Click ‘Continue’

● Click ‘Install’
● Click ‘Finish’

See Appendix Item 2B
for more detailed steps

Transfer T4A
Maps to GPS

using Windows

OR via BaseCamp:
Summary Steps:

● Menu: Maps > Install Maps (ie. will initiate built-in
MapInstall function)

● Find Device
● Choose device to install maps on (ie. internal GPS

memory or SD Card)
● Click ‘Customize’

● Select maps to transfer
● Click ‘Continue’

● Click ‘Install’
● Click ‘Finish’

See Appendix Item 2C
for more detailed steps

See Video above on
how to use the
MapInstall function
with Basecamp to
transfer the maps.
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OR via MapSource:

IMPORTANT TO NOTE: MapSource can
transfer & receive maps, waypoints etc. to and
from most Garmin GPS units - the Garmin
Drive GPS units don’t always work with
Mapsource.

Summary Steps:
● In Menu > Switch to product (ie. to select map to

transfer to GPS unit)
● Then: Tools > Map (ie. this is the Map Tool used to

select maps on the screen - maps will turn pink when
clicked on))

● Use Map Tool to select one or more maps.
● Only the pink selected map areas will transfer

to your GPS
● Then: Menu > Transfer

● Send to Device
● Find Device

● Choose device to install maps on (ie. internal
GPS memory or SD Card)

● Ensure ‘Maps’ is ticked
● Click ‘Send’

See Appendix Item 2D
for more detailed steps

Video not available.
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3. How to use T4A GPS Maps on your Garmin GPS
● At this point you should have successfully installed the T4A GPS Maps to your GPS unit.

Step Summary See Detailed Steps
Here

Step A Go to map settings and select only the T4A maps.
Do not select more than one type of map at a
time.

See Appendix Item 3A for
more detailed steps

Step B Check these extra settings on your GPS:
● Set preference to Fastest Time / Fastest Route
● Switch off Avoidances
● Set Map detail to more
● Ensure only the T4A Map is selected on your GPS
● Look at our YouTube video “Setting up your GPS”

See Appendix Item 3B for
more detailed steps

Setting up your
GPS

4. DON’T FORGET

Read about our Subscriptions Policy for Downloadable GPS
Maps

See Appendix Item 4A for more info

See this YouTube video for more info:

Check out the T4A Africa Guide on your T4A GPS Maps SD
Card

See Appendix Item 4B for more info
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5. HELP with MapInstall/BaseCamp/MapSource
For more information on how to use BaseCamp, please refer to Garmin’s help tutorials which
can be find on their website. At time of this publication this information was available from the
internet location below:
https://support.garmin.com/en-US/?productID=52801&tab=topics

Some important settings on BASECAMP
Make sure your settings on Basecamp is the same as the settings on your GPS else you will get
different results if transferring routes from Basecamp to your GPS unit.

In order to view and see POIs (ie. Lodges, campsites, restaurants etc.) on your screen - make
sure that your Map Detail is set to Highest.

1. Open Basecamp - Go to top main menu - click on “View”, then “Toolbars” and then
make sure “Detail Level” is ticked. See number 1 below.

2. You will notice a small block pop-up on your screen - make sure you choose “Highest”
from that drop-down list of options.
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6. T4A Videos to help you
Find Videos: On our Youtube Channel.

For Trip Planning  - see this playlist:

● BaseCamp Basics Full Tutorial - A detailed tutorial on basics of BaseCamp &
Tracks4africa Maps

● MapSource Basics FULL Tutorial - A detailed tutorial on basics of MapSource &
Tracks4africa Maps

● Setting Up Your GPS
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APPENDIX - DETAILED STEPS
1. How to Access and Install T4A GPS Maps to your PC

1A) Find and access the GPS Maps Download link file purchased
You need to download the links, which contain the T4A GPS Maps, that were
sent to you from T4A - they need to be installed on your PC.

Your download links are available:

● On the final order checkout screen on full payment on our online shop
when you placed your order:

○ Click on the Map Download link that you want to install and be
sure to choose the correct one for Windows or MAC OS.
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● OR On our online shop, under “My Account”. (ie. you have to be logged
in).

○ Go to “Subscriptions” and then “View” your subscription in order
to access the links.

○ Scroll down until you see “Downloads” (ie. as circled in blue in the
image below).

○ Note: The Product you have purchased is shown on the left (see
the black marker). The downloads available to you are shown on
the right (see the red marker).

○ There are various downloadable files available to you:
■ Users Guide - download the one for Windows or MAC -

depending on the operating system your are using.
■ T4A GPS Maps -  download the one for Windows or MAC

- depending on the operating system your are using.

● OR On your order email receipt from Tracks4africa for your purchase:
○ Click on the Map Download link that you want to download and

install and be sure to choose the correct one for Windows or
MAC OS.
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● OR from a download link email from T4A:
○ You can click on the “Click here” link to access your downloads

page on our server.
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○ If you are not logged in, you will be prompted to log in.
○ You will then see the “Direct Downloads” page - you then click on

the file you want to download.

○ Make sure you then either download a Windows or MAC file,
depending on your type of PC:

Once you have clicked on the link that you want to download and install,
your PC will indicate that it is busy downloading the link.

18



Go back to Quick Guide section

1B) Installing the GPS maps in the Download Link to your PC
The link is a zipped file, which contains an EXE file that you will run in order to
install the maps on your PC.

Please note: sometimes PCs do not allow files to be run for security reasons.
So If when following the steps below - your PC gives you a warning that the file
you are about to run will put your PC at risk - please do not be concerned - click
on the link “More Info”:

19



Then click on “Run anyway”.

If this is not available - take note that your firewall could be preventing you
from running the file: Go to Windows Security/Windows Defender to fix the
problem:

The installation process will start - follow the on-screen instructions.
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At this point you have now successfully installed the T4A GPS Maps Download link onto
your PC.

Go back to Quick Guide section
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1C) More Info on Free Software: MapInstall / BaseCamp /
MapSource
*Note: Info and download links for this software is supplied in the Quick Guide Section 1, Step 1C,
but read this section first.

Garmin offers three seperate FREE map viewing software options:

● BaseCamp: One can view the T4A GPS maps on this platform, plan trips,
transfer & receive maps, waypoints etc. to and from a GPS unit.

● MapSource: One can view the T4A GPS maps on these platforms, plan trips etc.
Note - To transfer & receive maps, waypoints etc. to and from a GPS unit is only
possible in MapSource with T4A GPS maps versions 18.05 and older.

● MapInstall. Which can only transfer maps to your GPS unit. Note that MapInstall
is a feature incorporated into BaseCamp too. It can also be installed and used as
a stand alone product to transfer maps to your GPS unit.

You can choose to use any of the software, many people prefer MapSource as it is
easier to use, although BaseCamp is the newer software, and MapSource may
eventually be phased out.

● Please note however: Before installing MapSource, you will have to install
BaseCamp, otherwise the MapSource installation won’t work.

● The T4A maps from version 18.10 onwards, can only be installed to Garmin
Devices using BaseCamp and MapInstall. MapSource will only work up to T4A
maps version 18.05. You can therefore not use Mapsource to install maps to your
GPS unit for our latest maps - but you can still use it for trip planning, and then
use MapInstall to transfer maps to your GPS unit.

The download links that are provided in Section 1 was correct at time of
publication. If you are unsure where to find these downloads, do a Google search for
“Garmin BaseCamp” or “Garmin MapSource”.

For more information on how to use BaseCamp, please refer to Garmin’s help tutorials
which can be find on their website. At time of this publication this information was
available from the internet location below:
https://support.garmin.com/en-US/?productID=52801&tab=topics

Some important settings on BASECAMP
In order to view and see POIs (ie. Lodges, campsites, restaurants etc.) on your screen -
make sure that your Map Detail is set to Highest.
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1. Open Basecamp - Go to top main menu - click on “View”, then “Toolbars” and
then make sure “Detail Level” is ticked. See number 1 below.

2. You will notice a small block pop-up on your screen - make sure you choose
“Highest” from that drop-down list of options.

Go back to Quick Guide section
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1D) Detailed Steps: Viewing the maps via BaseCamp
Firstly, you need to open Basecamp.

Basecamp will open up.
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Go Back to Quick Guide section

1E) Detailed Steps: Viewing the maps via MapSource
Firstly, you need to open MapSource.
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MapSource will open up.

To view the Map/s in Garmin MapSource go to View > Switch to Product and
select the T4A Map you would like to view.

29



The T4A map will now be displayed in your main window. You can zoom in and out,
using the magnifying icons in your menu, or pan around on the map, using the small
hand icon in your menu etc.

Go Back to Quick Guide section

2. How to transfer T4A GPS Maps from your PC to your GPS

2A). Connect your Garmin GPS Unit to your PC
Connect your Garmin GPS unit to your PC/Laptop via USB cable.

Remember that you can transfer the T4A GPS Maps to your internal memory or
SD Card in our GPS unit. If your Garmap maps are on your SD card, transfer
your T4A maps to the internal memory of your device, alternatively if your
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Garmap maps are on your internal memory, then transfer your T4A maps to the
SD Card.

2AA). Uninstall any previous T4A Maps from your GPS
1. From your PC: Please access any old T4A map versions on your PC

that you are now replacing via your Control Panel - and uninstall
them from your PC!

2. From your GPS: If the new T4A GPS map that you wish to install, is
on your GPS unit, but in an older version, rather uninstall it from
your GPS unit. Steps are here below.

Please take care NOT TO uninstall your Garmap/City Navigation maps!

Since your GPS unit is now connected to your PC -
Open MapInstall or Basecamp and initiate the Map Install function from within
Basecamp (ie. Go Maps/Install Maps). You will notice:

● Your GPS device will be picked up
● It will show the list of maps that it picked up in Basecamp that can fit onto

your GPS unit
● Click on “Customize” to continue...
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Now you can customize your install to your GPS unit:
● Keep your city navigation maps (garmaps) ticked so that you don’t loose

them.
● Untick all T4A maps / T4A Maps to be removed.
● Then click on “Continue”
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Take note of the message here - you will install some (ie. your city navigation)
and delete some (ie. the T4A maps). You will notice which maps will be:

● Installed
● Removed

Click on “Install” to continue. This will remove the maps you have unticked.
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When the installation is done, you will see this screen, click on “Finish”.

If you switch your GPS unit on now - go to your Map Info: you will notice only the
maps that you did not remove in the “uninstallation process” are still there.
There are no T4A Maps - as they have been uninstalled.
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Go Back to Quick Guide section

2B). Detailed Steps: Using MapInstall to transfer T4A Maps to
your GPS

MapInstall is a function that resides within Basecamp too - that is used to transfer GPS
Maps to a Garmin GPS Unit.

When transferring map/s to your GPS unit, MapInstall should be open and your
GPS system switched on and plugged in.

Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps
are on your SD card, transfer your T4A maps to the internal memory of your
device and vice versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from
your internal memory or SD Card on your GPS unit and from your PC, otherwise
the new T4A file will not be transferred. (See steps here)

Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card
slots (ie. one for the camera and one for maps):

● Be sure to remove the camera memory card to ensure that MapInstall will only
see the Map Memory card, so that the maps can be loaded onto the correct
memory card in the memory card slots.
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If you want to transfer your GPS maps to an SD Card:
● Recommended size: You could get away with a 2Gb card but maybe 4Gb is safer if

you want to load additional files such as our rich content guides.
● Formatting an SD Card: If formatting an SD Card it must be formatted to FAT or

FAT32. Either will work, but the recommended option is FAT32

Open MapInstall by launching it from your “Start” menu. (ie. if it is not listed in your Start
menu, do a search on your PC for it).

Please note that the MapInstall function is located within Basecamp as well - so you can
access this functionality from within Basecamp, or you can open MapInstall directly on
your PC.

When transferring map/s to your GPS unit, MapInstall should be open and your
GPS system switched on and plugged in. Each time a mapset is sent to a Garmin
GPS, the previously loaded maps are erased from the GPS. If you’re Garmap
maps are on your SD card, transfer your T4A maps to the internal memory of
your device and vice versa.

When MapInstall opens up, it should automatically list your GPS that is connected to
your computer. If not, search for it in the dropdown list next to “Device”.
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If there is an SD card in the GPS unit, you will notice that MapInstall lists your Device
name and the words “+SD Card” - see below. (ie. this means that the T4A maps will be
installed on the SD card).
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Then click “Customize” in the right bottom corner.

Then select the maps you wish to transfer to your GPS. Then click on “Continue”.

Then click on “Install” in order to install the maps to your GPS unit.

MapInstall will then continue with the installation process.
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When the installer has completed, click “Finish”.

You are done - your gps maps should be installed on your GPS unit.

Go Back to Quick Guide section

2C). Detailed Steps: Using BaseCamp to transfer T4A Maps to
your GPS
Open BaseCamp.

When transferring map/s to your GPS unit, MapInstall should be open and your
GPS system switched on and plugged in.

Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps
are on your SD card, transfer your T4A maps to the internal memory of your
device and vice versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from
your internal memory or SD Card on your GPS unit and from your PC, otherwise
the new T4A file will not be transferred. (See steps here)

Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory
card slots (ie. one for the camera and one for maps):
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● Be sure to remove the camera memory card to ensure that MapInstall will only
see the Map Memory card, so that the maps can be loaded onto the correct
memory card in the memory card slots.

If you want to transfer your GPS maps to an SD Card:
● Recommended size: You could get away with a 2Gb card but maybe 4Gb is safer if

you want to load additional files such as our rich content guides.
● Formatting an SD Card: If formatting an SD Card it must be formatted to FAT or

FAT32. Either will work, but the recommended option is FAT32

In BaseCamp, click on the menu item Maps > Install Maps: (ie. this is the MapInstall
feature incorporated within BaseCamp)

You will notice that this then initiates the MapInstall function. Please follow the
following steps on the screens to complete this process:

40



Your Device name will then pop up in the Device list, and in the bottom window a list of
all the possible maps that can be transferred and that will fit onto your GPS unit is
displayed.

● If your device is not listed under the “Device” drop down list, then click on “Find
Device” in order to allow your PC to read and recognise your connect GPS unit.
(ie. if your GPS unit is not connect to your PC, then it will not appear in this drop
down list).

● Under “Device” you can choose to send the T4A GPS maps to your GPS units’
internal memory, or to the SD card (if you have one inserted into your GPS)
which will be listed as “Removable Media” or “Removable Disk” etc. (Note: heed
warning at beginning of this section in red about taking care not to overwrite Garmap or
other maps already on your GPS).
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If there are multiple maps that appear in your list and you only want to send specific
map/s to your GPS, then click on “Customize”. The following screen will appear where
you can customize which maps you want to send by ticking the checkbox:

If you click “Continue”, MapInstall will show you what it is going to install, uninstall etc.
on your GPS unit, for example:
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Click on “Install” to start the process. This screen will typically appear:

When completed, you can click on “finish” in this screen:

43



Go Back to Quick Guide section

2D). Detailed Steps: Using MapSource to transfer T4A Maps to
your GPS
IMPORTANT TO NOTE: MapSource allows you to view the T4A GPS maps, plan trips
etc. MapSource can only transfer & receive maps, waypoints etc. to and from a GPS unit
for T4A GPS Maps version 18.05 and older...The latest T4A GPS maps cannot be
transferred to/from a GPS unit with Mapsource.

Therefore, if you have T4A GPS Maps version 18.05 or older then:

Open MapSource.

When transferring map/s to your GPS unit, MapSource should be open and your
GPS system switched on and plugged in.

Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps
are on your SD card, transfer your T4A maps to the internal memory of your
device and vice versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from
your internal memory or SD Card on your GPS unit and from your PC, otherwise
the new T4A file will not be transferred. (See steps here)
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Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card
slots (ie. one for the camera and one for maps):

● Be sure to remove the camera memory card to ensure that MapSourcel will only
see the Map Memory card, so that the maps can be loaded onto the correct
memory card in the memory card slots.

If you want to transfer your GPS maps to an SD Card:
● Recommended size: You could get away with a 2Gb card but maybe 4Gb is safer if

you want to load additional files such as our rich content guides.
● Formatting an SD Card: If formatting an SD Card it must be formatted to FAT or

FAT32. Either will work, but the recommended option is FAT32

1: In MapSource, go to View > Switch to product and select the mapset you wish to
transfer. The map will be visible in front of you. If not, use the zoom button to zoom in or
out to find the map on your screen. (ie. a previous step explains how to view and access
the maps in MapSource)

2: Go to Tools (at the top of the toolbar) and select ‘Map’. The Map tool is used to
select the map/s you want to transfer to your GPS unit.

That will initiate the “Polygon” Map Tool icon - visible on your cursor:
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The T4A map is divided into 16 regions - depending on which map your purchased
from T4A, you will notice the map light up in yellow as you hover your mouse over the
different map regions. (ie. in this example below, the entire map was purchased, which
includes all 16 regions)

When you click on the map with the Maptool, the map will turn pink (see
example below). If not, zoom in to the map in order to see the selected pin map area.
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If you want to transfer more than one map to your GPS system, repeat step 1
and 2 above, by selecting the map(s) you want to transfer to your GPS unit..
If you’ve purchased the Full Map Set and you want to transfer the full set, please
make sure that the 16 map sets is selected before transferring the maps.
If you only want to transfer a few of the map tiles only, then select only those
you want to transfer for example Namibia, Botswana or East Africa.

3. To transfer the map/s to your GPS, select Transfer on the toolbar, and then
Select “Send To Device”.

The “Send To Device” pop up screen will appear:
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● If your device is not listed under the “Device” drop down list, then click on “Find
Device” in order to allow your PC to read and recognise your connect GPS unit.
(ie. if your GPS unit is not connect to your PC, then it will not appear in this drop
down list).

● Under “Device” you can choose to send the T4A GPS maps to your GPS units’
internal memory, or to the SD card (if you have one inserted into your GPS)
which will be listed as “Removable Media” or “Removable Disk” etc. (Note: heed
warning at beginning of this section in red about taking care not to overwrite Garmap or
other maps already on your GPS).

● Ensure “Maps” is ticked, as this is what you want to send to your GPS.
● Then click “Send” to transfer the maps to your device.

When completed, the T4A GPS Maps will now be available on your GPS unit.

Go Back to Quick Guide section

3. How to use T4A GPS Maps on your Garmin GPS

3A) Select Only T4A Maps on your GPS

Switch on your GPS then:
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1. You have to enable the T4A GPS Maps on your Garmin Device: If you have Street
Navigation Maps on your unit on the internal memory, you cannot run T4A GPS Maps
and your street maps (ie. Garmaps) at the same time. Please be sure to only select
T4A GPS Maps if you want your unit to navigate you from our maps, or vice versa. (ie.
Never use any two map products for the same area at the same time as it may result in
conflicts. Simply select which one you need and switch the other off).

Depending on what GPS unit you have, the setting will differ from GPS range to GPS
range. It is usually under the “Settings” and then “Mapinfo” on your GPS unit. For Nuvi
and Zumo units, this can be found by clicking on the ‘spanner’ (Tools). Then select
Settings>Map>MapInfo to get to the screen where map selection is made.

If you have any previous versions of T4A GPS Maps installed on your GPS’s internal
memory you will need to remove those maps.

See more examples of how to enable this setting on:
● The newer Garmin Nuvi range
● Garmin Montana range

Steps on the newer Garmin Nuvi range: (Please note that the older Garmin Nuvi
range will work differently to the newer units)

● Switch on your GPS and select Settings on the home page.
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● Then select Map & Vehicle on the next page.

● On the next page, scroll down and select myMaps. All your installed GPS Maps will be
listed here.

● Enable the map you wish to use on your GPS by selecting the tick box. Remember that
you may only have one map product enabled (ticked) otherwise the GPS won't know
which map to use and will give navigation errors.
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Steps on the Garmin Montana range:
● On the homepage of the GPS, click on the arrow on the left-hand side of the screen.

● Select Setup on the next page

● Then select Map.
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● Click on Map Information and then Select Map.

● Click on the map you wish to enable on your GPS device.

● Select Enable in order to have the GPS map of your choice enabled. Remember that
you may only have one map product enabled otherwise the GPS will give navigation
errors.
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Go Back to Quick Guide section

3B) Check these extra settings on your GPS

Here are a few tips to get the most out of your T4A GPS Maps on your GPS:

Switch on your GPS then check:

1. Route preference: Route Calculation should be set to Fastest Time / Fastest Route.

2. Route preference: Avoidances, should all be switched off ie. unticked.

3. Map Detail: Should be set to “More” or “Most”

4. Make sure that the Tracks4Africa map is the only map selected under your My Maps
settings (see 3A) Select  Only T4A Maps on your GPS)

Make sure your settings on Basecamp is the same as the settings on your GPS else you will get
different results if transferring routes from Basecamp to your GPS unit.

Go Back to Quick Guide section

4. DON’T FORGET TO:

4A) Read about our Subscriptions Policy for Downloadable GPS Maps
Note: this policy came into effect 01 May 2018.
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At Tracks4Africa, we aim to officially update our Download GPS Maps for Garmin units at least
four times a year - depending on the amount of content changes made to our maps:

● Month 1 (March)
● Month 2 (June)
● Month 3 (September)
● Month 4 (December)

You can subscribe to:
● Single Downloadable Maps
● Complete Set of Downloadable Maps for a 1 year or 5 year subscription

If you have subscribed to a Downloadable Map:
● Once purchased, you will be entitled to all the map updates we release within the

next 12 months or 5 years, depending on the option you subscribed to. This could be
up to four updates in a year as we aim to release updates every quarter, but it may
also depend on the number of changes we make to our map content. We will
however release at least two map updates per year.

● For the Complete Set of Downloadable Maps only for the 1 year subscription: Any future
purchase of the complete set/GPS Maps on SD Card will then be at a 50% discount
regardless of when you come back to buy.

● There are no further 50% discounts on the single or 5 year map subscriptions.

Free Upgrade
Note that there is  no longer a free upgrade for downloadable maps that were purchased, when
a new release is released. Instead you now enter into a yearly or 5 year subscription with
us, and you will be entitled to all the map updates we release within the next 12 months or 5
years. (ie. you now receive subscription upgrades).

For more information please refer to this PAGE on our shop.

Go Back to Quick Guide section

4B) Checkout the T4A Africa Guide on your GPS
The Africa Guide is a digital file that is included on the T4A GPS Maps SD Card. It contains
information, where available, on the POIs (Points of Interests eg. Lodge, Campsite, Restaurant
etc.) that are on our GPS Maps.

If you have purchased our Complete set of downloadable Maps, you can request the latest
Africa Guide from our salesteam.

This Africa Guide can be accessed under "Extras" on your compatible Garmin Device.
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This Africa Guide enables you to look up descriptions, contact details, rates, facilities and
activities on offer for lodges and campsites in Africa directly on your GPS. Also included are
searchable picnic sites and border control information, perfect for your next road trip.

You can also look up information on various attractions (eg. wine farms) and activities (eg.
4WD-trail) that exist as Points of Interests (POI) on our maps.

Note: we no longer publish photos on this guide, as it increases the size of the guide
tremendously, and will then take up to much space on a GPS unit.

See the category "Communications": use this to find the nearest point selling airtime, offering
internet access, or wireless, or where the nearest public phone is, or a good mobile reception
spot.

Also see our "Shopping" category: to help you find your nearest shop of choice, and the
nearest place selling gas.

For more information on this guide, how to install it ec. please have a look on our website here.

Go Back to Quick Guide section
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